Kurzweil 3000 (Win) v.12
Navigating Documents
Introduction
Kurzweil 3000 is reading and writing software that has many features designed to support
students who are struggling with reading comprehension and written output. The program can
be used as a word processor or it can be used to scan documents, like textbooks or worksheets,
which can then be read aloud or completed within the program. Students with a wide variety of
abilities and challenges can use Kurzweil 3000 effectively. Kurzweil 3000 has several built in
options for navigating single or multiple page documents. The ability to navigate documents is
an important skill for both students and those who prepare documents for their use. While
completing this tutorial, you will learn how to use the various document navigational options.
This tutorial assumes…
 Kurzweil 3000 version 10 for Windows is installed on your computer. If you do not
have the program already installed, please refer to the installation and registration
instructions that came with your software.
 Your computer system supports audio output either through speakers or a headset.

Learning Objectives
Completion of this tutorial will give you experience with the following:
 using the zoom feature to zoom in or out of documents
 setting “My Zoom” or custom zoom value
 using the page thumbnail tool to navigate single page documents
 using the document thumbnail and previous/next page tools to navigate multiple
page documents
 creating and using bookmarks

Case Study
Cindi is a Grade 7 student who has a visual impairment making it difficult for her to read regular
font sized on the computer. Together with her Special Education Assistant, she scans her
textbooks and novels and uses the various text reading tools in Kurzweil 3000 to have her
materials read aloud. This supports her reading comprehension and also decreases her eye
strain. Since she is dealing with large, multi-page documents, she has been taught how to use
the various tools to help with navigation. She has set the My Zoom value to 150% which allows
her to quickly jump to that level on any document. She also makes extensive use of bookmarks
which she places, with help from her SEA, into textbook and novel documents. In textbooks,
the bookmarks identify major chapter sections; in novels they identify chapters. Cindi’s SEA
spent time with her when she first began using Kurzweil 3000 to ensure she clearly understood
how to use the navigational features of the program so she has become very independent and
is free to concentrate on the content of her documents.
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Using the Zoom In and Zoom Out Feature
Kurzweil 3000 was originally designed for
students with visual impairments so it has
excellent support for those who require larger
font sizes or enlarged images. Students can
quickly zoom in or out of documents to suit
their visual or cognitive needs.

1

To see how to use zoom in and out, open an
image document. Go to File  Open and
locate the Sample Documents folder (it is in
My Documents  KESI  Kurzweil 3000). In
this folder you will see a document called
“Condor”. Double-click to open it.

On the Reading Toolbar (the one with the
yellow bar), you will find the Zoom in and
Zoom out arrows. Click the Zoom in arrow to
increase the zoom level. Clicking the Zoom
out arrow decreases the zoom level.
You can also select from a list of zoom values
by clicking the down arrow next to the current
zoom value.

2

In addition to the standard zoom values, you
can also select a value based on the
individual page height, width or the text height
and width. This allows you to quickly see the
entire page or text portion of the page in the
Kurzweil window.
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If you want to set a very specific zoom level,
you can type in the value in the zoom field and
then click Enter on your keyboard to set that
value.
1. Type in value
2. Click Enter on keyboard

3

Another way to access the zoom values is
through the View menu. Go to View  Zoom
and notice that you can choose to zoom in
and out by 10%, go to 100% or go to your My
Zoom value.

Tip…
Keyboard shortcuts are a great way to increase your student’s efficiency when using the Kurzweil
3000 program. Notice there are keyboard shortcuts to quickly zoom in and out of the document.
Once you’ve set the My Zoom value, described in the next section, teaching your student to press
Control-M on the keyboard jumps them to that value immediately.
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Setting the My Zoom Value
While choosing the zoom value from the
reading toolbar drop down list, you may have
noticed a “My Zoom” option. This is very
handy because you can specify what value
you would like and use this to quickly jump to
that value on any document.

1

To set your own My Zoom value, go to Tools
 Options  General Options. On this
General Options tab, in the lower right corner,
you will find the My Zoom field.
Type a custom zoom value in this field.
Click OK to close the Options window. Now
when you select My Zoom from the drop down
list on the Reading toolbar, you will zoom in
(or out) to your custom zoom value.
The My Zoom value is also useful if you want
to have all documents automatically open to
that value. To set this option, go to Tools 
Options  Image. On the right side of the
window, under “Extras”, you will find a drop
down list for Default Fit. Select My Zoom
from the list, click the Apply button to save
that setting, and OK to exit the Options
window.
Now, all documents will open to the value you
assigned as My Zoom.
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Tip…
The My Zoom values are connected to the user that has signed into the Kurzweil 3000 program. If
you are using the program with multiple users, you can set a different My Zoom value for every
student.
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Navigating a Single Page Document
If your student uses a large zoom value (like
200% or more) to view his or her document,
you may need to use the Page Thumbnail
feature to move around the page.
You can access this feature by clicking the
Page Thumbnail tool located on the right side
of the Reading Toolbar.

When you do, a side area will open up
showing you a thumbnail of the current page.
You can click and drag the red box around
the thumbnail to move your viewing window
area.

1

You can also click the arrows located at the
bottom to move the viewing window area
around the page.

Click the Page Thumbnail tool again on the
toolbar to close this tool.

Note: You can also access the Page
Thumbnail by going to
View  Thumbnails  Page Thumbnail.
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Navigating a Multi-Page Document
Many of your student’s scanned documents
will contain more than one page. There are
several ways to efficiently navigate multi-page
documents.
Open the “History Textbook” sample
document. Click the Open tool on the main
toolbar and locate the Sample Documents
folder.
(Open  My Documents  KESI  Kurzweil
3000  Sample Documents)

1

This document has six pages. On the
Reading toolbar there is a quick navigational
area that allows you to move up and down
page by page or jump to the first or last page
in the document.

Previous page

First page

Next page

Last page

Click the Next arrow to move to the next page.
Click the Previous arrow to move to the
previous page. Click the “1” button to move to
the first page in the document and the “6”
button to move to the last page.
If you know the page number you want to
jump to directly, you can type it into the page
number field and click Enter on your
keyboard.

In the previous section, you used the Page
Thumbnail tool to navigate around on a single
page. Kurzweil 3000 also has a Thumbnail
view of document tool. It is located right next
to the Page Thumbnail tool on the Reading
Toolbar.

2

Click this button and a window opens up
showing you thumbnail views of all pages in
the document.
Click on any page to jump to that page. If you
are viewing the thumbnails, you can also
return to your document by clicking the
Thumbnail view of document button to close
the thumbnail window.
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You can adjust the size of the thumbnails –
this is handy if you have a very large
document or are working with a student who
has a visual impairment.
Go to View  Thumbnails  Thumbnail
Size and select an appropriate size.
Note: You can also go to Thumbnail View
from the View menu as well.

Tip…
If you are working with a “complicated” document, like many of today’s textbooks, you may also
want to use the Page View option under the View menu to “Remember” your preferred page view.
That way, each time you jump to that page, it will open to the view that you want. This removes the
need to constantly use the My Zoom option each time a page is opened.
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Creating and Using Bookmarks
One of the tools available in Kurzweil 3000
that is particularly handy for navigating multipage documents is the Bookmark tool. It can
be used to mark significant points in a
document like chapter or section headings.
Bookmarks are easily created – many
students can create and use them
independently.
On the History Textbook file that you currently
have open, go to page 2 of the document.

1

Click to place your cursor next to the title of
the chapter (A Roaring Decade).

If your Study Skills toolbar is not open, click
the green bar on the left hand side of the
toolbars to open it.

You will find the Bookmark tool on the right
hand side of the Study Skills toolbar.

Click the Bookmark tool and a window will
open up which allows you to add a bookmark
where your cursor is placed in the document.

2

Type in the name of the bookmark in the
Description field. Click the Add button to add
your new bookmark.
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A bookmark has been added to the chapter
title.

If you would like to change the size of the
bookmark icon, you can easily do so by going
to Tools  Options  Image and selecting a
“Large” or “Small” Note Marker Size under
the Extras list.

You can go ahead and add other Bookmarks
to the document – set your cursor, click the
Bookmark tool, give it a name and click the
Add button.
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Once you’ve added bookmarks to your
document, you can quickly move to those
spots by clicking the Bookmark tool on the
Study Skills toolbar. This time, instead of
adding a new bookmark, click on any of the
existing ones to highlight it (notice Kurzweil
3000 reads the Bookmark aloud) and then
click the Go To button.
Note: You can also double-click the name of
the bookmark to go there.
In addition to adding and going to bookmarks
on the Bookmarks window, you can change
the order in which they are listed – either
Alphabetical or by Reading order.

3

You can also Delete any Bookmark at any
time by highlighting it and clicking the Delete
button.
Click OK to exit this window.

Note: You can also access the Bookmark tool
from the Tools menu.
Tools  Bookmarks… or by pressing
Ctrl + F12 on your keyboard.

Tip…
Bookmarks are very versatile and can be used for more than simply marking chapter and section
headings. For example you can set bookmarks at specific areas of the text you want the student to
read or text that will answer comprehension questions. Teaching students to use bookmarks will
help them develop skills in identifying key concepts or main ideas.
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Checklist of Skills Developed in this Tutorial
 Open sample documents from the Kurzweil 3000 Sample Documents folder
 Zoom in and out of a document using the zoom features on the Reading toolbar
 Set and use the My Zoom feature to customize document viewing
 Use the Page Thumbnail to navigate individual document pages
 Use the Thumbnails of Document tool to navigate multi-page documents
 Adjust the size of the document thumbnails
 Create and use bookmarks to help navigate multi-page documents
Now that you’ve completed this tutorial on navigating scanned documents, you may want to look
at the tutorial that describes how to manage your Kurzweil 3000 files.
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